OptiFDTD
Getting Started

Finite-Difference Time-Domain Simulation Design

for Microsoft Windows® XP / Vista / 7 / 8
# Table of Contents

1  Installing OptiFDTD .................................................. 5  
   1.1  Hardware and software requirements .................................. 5  
   1.2  Protection key .......................................................... 5  
   1.3  OptiFDTD directory .................................................... 5  
   1.4  Installation ............................................................. 6  
   1.5  OptiFDTD samples ...................................................... 6  
   1.6  Technical support ........................................................ 7  
2  Introduction to OptiFDTD ................................................. 8  
   2.1  What are OptiFDTD and FDTD? ......................................... 8  
   2.2  OptiFDTD workflow ..................................................... 9  
   2.3  OptiFDTD coordinates system ......................................... 10  
3  Quick Start ............................................................... 12  
   3.1  Starting OptiFDTD ...................................................... 12  
   3.2  Opening the sample ring resonator project file ....................... 13  
   3.3  Verifying the FDTD domain dimensions ................................. 15  
   3.4  Verifying the Materials properties ..................................... 16  
      3.4.1  Opening the dielectric material properties ....................... 17  
      3.4.2  Opening the profile properties ................................... 19  
   3.5  Verifying the geometry of the ring .................................... 21  
   3.6  Checking the properties of the input source .......................... 23  
      3.6.1  Obtaining the geometrical parameters of the source ............. 24  
      3.6.2  Reviewing the temporal definition of the source ................ 25  
      3.6.3  Defining the light distribution properties ....................... 26  
   3.7  Checking the Detectors definition .................................... 29  
   3.8  Running a 2D simulation ............................................... 31  
   3.9  Analyzing the simulated data ......................................... 33  
      3.9.1  Observing the time series data ................................... 34  
      3.9.2  Extracting spectral information ................................... 34  
      3.9.3  Exporting the data to file ....................................... 36  
   3.10  Working with the 3D editor .......................................... 36  
      3.10.1  Mouse Navigation ................................................ 38  
      3.10.2  3D editor toolbar ................................................ 38  
      3.10.3  Selecting objects in the 3D view ................................ 39
Copyright © 2014 Optiwave
All rights reserved.
All OptiFDTD documents, including this one, and the information contained therein, is copyright material. No part of this document may be reproduced, stored in a retrieval system, or transmitted in any form or by any means whatsoever, including recording, photocopying, or faxing, without prior written approval of Optiwave.

Disclaimer
Optiwave makes no representation or warranty with respect to the adequacy of this documentation or the programs which it describes for any particular purpose or with respect to its adequacy to produce any particular result. In no event shall Optiwave, its employees, its contractors or the authors of this documentation, be liable for special, direct, indirect, or consequential damages, losses, costs, charges, claims, demands, or claim for lost profits, fees, or expenses of any nature or kind.
1 Installing OptiFDTD

Before installing OptiFDTD, ensure the system requirements described below are available.

1.1 Hardware and software requirements

OptiFDTD requires the following minimum system configuration:

- Microsoft Windows XP/Vista/7
- 64 bit operating system and processor (Intel x64 or AMD64)
- Personal computer with Pentium 4 or higher processor 1.2 GHz (or higher). Multi-core CPU is required for increased performance of parallel processing simulators.
- 2GB of RAM or higher (dependent on the size of calculated problem)
- 500 MB to 10 GB free hard drive disk space depending on calculation size for storage of the simulation results
- 1024 x 768 graphic resolution, minimum 256 colors

1.2 Protection key

A hardware protection key is supplied with the software.

Note: Please ensure that the hardware protection key is NOT connected during the installation of OptiFDTD.

To ensure that OptiFDTD operates properly, verify the following:

- The protection key is properly connected to the parallel/USB port of the computer.
- If you use more than one protection key, ensure that there is no conflict between the OptiFDTD protection key and the other keys.

⚠️ Use a switch box to prevent protection key conflicts. Ensure that the cable between the switch box and the computer is a maximum of one meter long.

1.3 OptiFDTD directory

By default, the OptiFDTD installer creates an OptiFDTD directory on your hard disk. It is located by default under:
The OptiFDTD directory contains the following subdirectories:

- bin — executable files, dynamic linked libraries
- doc — OptiFDTD support documentation

The documentation and executables have shortcuts in the start menu (or tiles in windows 8).

### 1.4 Installation

OptiFDTD can be installed on 64 bit versions of Windows XP, Vista or Windows 7. We recommend that you exit all Windows programs before running the setup program.

To install OptiFDTD proceed according to the following procedure:

1. Log on as the Administrator, or log onto an account with Administrator privileges.
2. Insert the OptiFDTD installation CD into your CD ROM drive.
3. On the Taskbar, click Start and select Run.
   
   The Run dialog box appears.
4. In the Run dialog box, type F:\setup.exe, where F is your CD ROM drive.
5. Click OK and follow the screen instructions and prompts.
6. When the installation is complete, reboot your computer.

### 1.5 OptiFDTD samples

The samples installer runs directly at the end of the installation of the main OptiFDTD application. By default, the samples are installed under your My Documents directory, in a folder named OptiFDTD 12 Samples. The default location can be changed in the installer.

If needed, you can re-install the samples by double clicking the file OptiFDTD_Samples_x64.exe in the OptiFDTD 12 installation directory.

You will also find more samples and applications cases online. Simply select Help->Download Samples from OptiFDTD, or visit http://www.optiwave.com/optifdtd/ for more information.
### 1.6 Technical support

<table>
<thead>
<tr>
<th></th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Phone</strong></td>
<td>(613) 224-4700—Monday to Friday, 8:30 a.m. to 5:30 p.m. Eastern Standard Time</td>
</tr>
<tr>
<td><strong>Fax</strong></td>
<td>(613) 224-4706</td>
</tr>
<tr>
<td><strong>E-Mail</strong></td>
<td><a href="mailto:support@optiwave.com">support@optiwave.com</a> (<a href="mailto:support@optiwave.com">mailto:support@optiwave.com</a>)</td>
</tr>
<tr>
<td><strong>URL</strong></td>
<td><a href="http://www.optiwave.com">www.optiwave.com</a> (<a href="http://www.optiwave.com/">http://www.optiwave.com/</a>)</td>
</tr>
</tbody>
</table>
2 introduction to OptiFDTD

2.1 What are OptiFDTD and FDTD?

OptiFDTD is a powerful, highly integrated, user-friendly software that allows computer aided design and simulation of advanced passive photonic components.

The OptiFDTD software package is based on the finite-difference time-domain (FDTD) method. The FDTD method has been established as a powerful engineering tool for integrated and diffractive optics device simulations. This is due to its unique combination of features, such as the ability to model light propagation, scattering and diffraction, reflection and polarization effects. It can also model material anisotropy and dispersion without any pre-assumption of field behavior such as the slowly varying amplitude approximation. The method allows for the effective and powerful simulation and analysis of sub-micron devices with very fine structural details. A sub-micron scale implies a high degree of light confinement and correspondingly, a large refractive index difference of the materials to be used in a typical device design.

A Yee cell. Magnetic field components are represented in blue, electric field components are shown in red.

The technique relies on discretization of the problem to model both in space and time. Electromagnetic fields are discretized following a mesh of so-called Yee cells. Magnetic and electric field components are positioned in a staggering fashion on the edges of each cell. By calculating the finite difference between two field components on opposite edges of the cube, it is possible to obtain an approximation of the space-domain derivative of the field. Finite differences are used in the same way to approximate time-derivatives of the fields. The algorithm used to compute and update for each time step the electric and magnetic fields is called the Yee algorithm. More details are given in the Technical Background manual. The solution to the computational problem is exact when the mesh size and time-steps size tend to zero. This means that the finer the mesh, the better is the precision, but the slower and bigger is the simulation. The FDTD simulation domain consists in a 2D or 3D mesh of Yee cells, each cell representing a small volume with set material properties. Materials in OptiFDTD can be of varied types:
Getting Started

- isotropic and diagonally anisotropic dielectrics
- dispersive (Drude, Lorentz, Lorentz-Drude) materials
- perfect conductors
- nonlinear (2nd or 3rd order, Kerr, Raman) materials

In addition to these materials, a FDTD simulation will typically need light sources and some detectors to be able to inject power into the mesh and monitor fields both temporally or using Discrete Fourier Transforms (DFT) for monitoring spectral characteristics.

2.2 OptiFDTD workflow

Creating and running a FDTD simulation using OptiFDTD can be accomplished using 4 main programs, described below:

- **OptiFDTD Designer**— The main OptiFDTD program. From here, you can create new designs, set simulations parameters, write scripts and start simulations. Data are saved in a project file with the extension `.fdt`.

- **Profile Designer**— This program is used to define all the materials and profiles used in the simulation region. Profiles are a special type of objects used to define cross-sections of waveguides.

- **OptiFDTD Simulator**— Processes project files designed in OptiFDTD_Designer (.fdt). OptiFDTD_Simulator opens automatically when you start a simulation. The simulation results are stored in a file with the extension `.fda`. You can choose to open OptiFDTD_Analyzer at the end of the simulation.

- **OptiFDTD Analyzer**— Loads and analyzes the result files produced by OptiFDTD Simulator (.fda). Contains extensive viewing options and analysis features, and has the facilities to export data to other file formats.

A typical FDTD simulation design sequence can be defined as this: first define the simulation domain sizes, then define materials and profiles to be used in the simulation, then create the objects, light sources, and detectors that compose the simulation, run the simulation and finally analyze the results. The workflow of a typical simulation using OptiFDTD is shown below.
2.3 OptiFDTD coordinates system

OptiFDTD uses a coordinates system different from most 3D layout and editing software. The coordinate system is defined in order to be compatible with other Optiwave software such as OptiBPM. A representation of the coordinate system used is shown below.
The regions named Substrate and Cladding are used to separate volumes below and above the XZ (Y=0) plane. They are used to represent traditional waveguides fabricated using lithography for example. Substrate and Cladding regions can have different background materials attached to them.

While working with OptiFDTD, you must take note of the following conventions:

- X is referred to as the width or vertical component
- Y is referred to as the depth
- Z is referred to as the length or horizontal component
- The 2D and 3D simulation domains are referred to as 2D and 3D wafers.

It is possible to run either 2D or 3D simulations using OptiFDTD. In the case of 2D simulations, the simulation region is defined by the XZ plane.
3 Quick Start

This section describes how to open a sample project, navigate through the user interface to verify parameters, run a simulation and finally visualize and export simulation results.

⚠️ The most efficient way to learn how to use OptiFDTD is to complete the lessons in the Tutorials, where you will learn how to create more advanced projects that suit your needs.

In this section, we will simulate the propagation of light through a ring resonator and analyze the results of simulation. Finally we will export some of the results to file.

3.1 Starting OptiFDTD

Most of the work of modeling objects and structures for simulation is done in the OptiFDTD Designer environment. To open the application, perform the following steps:

To open OptiFDTD_Designer, from the Start menu, select Programs > Optiwave Software > OptiFDTD > OptiFDTD Designer.

OptiFDTD Designer loads and the main application window appears.
Getting Started

3.2 Opening the sample ring resonator project file

To load the ring resonator sample file, perform the following procedure.

1. From the File menu, select Open.
2. Navigate to your installation folder and select `Samples > sample02_3D_ring_resonator.fdt`
Ring resonator sample project

The default view displayed in the **Main window** area represents the ring resonator design. The default view is set to display only the **2D layout** (XZ). The **horizontal** dimension correspond to the **Z axis**, while the **vertical** dimension correspond to the **X axis**. It is possible to change views by clicking on the **view tabs**.

The left frame is called the **Project browser**. This is the place where all objects, sources and detectors are displayed. Each node of the project browser represents an element. Parent elements can be collapsed or expanded by clicking the + or - sign next to their name. Right clicking on a node bring a contextual menu for either deleting the node or accessing its properties. You can also access its properties by double-clicking the node.

Below the Main window is the **Output window**. It is used to display the output from scripts. If errors are presents, they will be displayed in the error tab.

The **Toolbars** represent shortcuts to many functions of the software, such as creating objects and waveguides, resizing the view, selecting elements and display options. They can be activated or deactivated by right clicking in an empty area of the toolbars regions. All the functions present in the toolbars are also accessible via the **Menubar**, by navigation across the different menus.
Getting Started

Finally, the **Status bar** displays information on the position of the mouse cursor inside the layout and if the program is ready or busy doing calculations.

⚠️ If the design is too small or too big to view on the screen, you can zoom in or out using the + and - button in the toolbar on the top of the Main View.

### 3.3 Verifying the FDTD domain dimensions

The global dimensions of the FDTD calculation domain (or mesh size) can be defined by doing the following:

- Double-click on the node named **Simulation Domain**, under **Global Properties** in the project browser.

  *The Wafer properties dialog opens.*

**Wafer properties dialog**

In the **Wafer Dimensions** tab, you can set the 2D dimensions of the FDTD grid:

- **Length** defines the **Z direction** dimension of the grid
- **Width** defines the **X direction** dimension of the grid
Getting Started

- All units are in microns.

In the *2D Wafer Properties* tab, you can define the background material to use for the simulation. In our case, it is set by default to *Air*.

### 3.4 Verifying the Materials properties

Once the dimensions are set, we want to see which material are defined in this simulation.

- Double-click on the node named *material*... in the project browser.
  
  *The Profile Designer application opens.*

*Profile Designer application window*

In the left pane of the *Profile Designer*, you can find the definitions of the material used in this simulation and the profiles defined.

- **material** can be dielectric material, dispersive, nonlinear material or Perfect Electric Conductors (PEC). Each type of material is arranged in a dedicated folder.

- **Profiles** are special structures containing information about waveguide cross-sections and material distribution. You can use:
  - **Channel profiles**, which define rectangular waveguide profiles
  - **Fiber profiles**, which are used for cylindrical profile definitions
Getting Started

- **User-Defined distribution material profiles** to define equation-based distribution of the material across the profile.

> Every waveguide or lens used in your layout will need to have a profile attached, as defined in the profiles folder of the Profile Designer. Only 3D objects (spheres, ellipsoids, blocks and cylinders) can use directly the material defined in the material folder.

On the root of the project browser, you can find 2 items (green cylinders):

- **Master**
- **your_project_name**

These correspond to the active project databases open in the designer. The **Master** database is always open by default. It contains many material definitions, useful to quickly set some common material in the simulation. The other databases are contained in any open project. When you add or remove material definitions or channels etc., changes are automatically embedded in your project file. To use a material defined in the **Master** database in your project, do the following:

1. Locate the material you want to use in the **Master** database
2. Drag and drop the material name in the corresponding folder of your project: dielectric material must be dropped in the **Dielectric** folder etc.
3. Click **Store** in the **Material Properties** to save the change

**3.4.1 Opening the dielectric material properties**

To open the **Waveguide2.0** material definition, do the following:

- Double-click on the node named **Waveguide2.0...** of the **Dielectric** folder under **Materials** in the project browser.

  *The **Waveguide2.0** material properties dialog opens.*
In this dialog, you can define a basic dielectric material by its refractive index. You can select whether to use an isotropic or anisotropic material and specify the real value and imaginary values of the refractive index (in the boxes labeled $\text{Re}$ and $\text{Im}$ respectively).

⚠️ The refractive index definition follows the engineering convention. It means that:

- $\text{Im} > 0$ in the refractive index will model a material gain
- $\text{Im} < 0$ in the refractive index will model a material loss

⚠️ The refractive index defined here is only valid for the central wavelength of the light source used. For simulations using Gaussian modulated waves, this will result in non physical representation of the material as the wavelength departs from the central wavelength. For more accurate models, taking into account chromatic dispersion, please consider using dispersive material definitions.
Getting Started

3.4.2 Opening the profile properties

Information concerning how the material is distributed across a cross-section of waveguide is defined in the Profiles section of the project browser, view of the Profile Designer. To open the waveguide profile, proceed to the following:

- Double-click on the node named waveguide of the Channel folder under Profiles in the project browser.

  The waveguide profile properties dialog opens.
Waveguide profile properties

In 2D, the profile consist only in the material definition. You can see that in the 2D profile Definition list, the Waveguide2.0 previously described is selected. If you change the material affected to the profile, don't forget to click on the Store icon.

Profiles are only useful when dealing with 3D waveguides.

You can now close the Profile Designer window and return to the main OptiFDTD application.
3.5 Verifying the geometry of the ring

The geometrical properties of the ring can be accessed and modified in 3 different ways:

- By double-clicking on the ring drawn in the Main window
- By double-clicking on the node named Ring1 in the project browser
- By right-clicking on the node named Ring1 in the project browser and selecting Properties

To load the ring object properties, perform the following procedure.

- Double-click on the node named Ring1 in the project browser.  
  *The Ring waveguide properties dialog opens.*
The first tab on the top of the dialog, named *Center*, is used to define the position of the center point of the ring.

- The **Z center position** is controlled by the **Horizontal** control.
- The **X center position** is controlled by the **Vertical** control.

Each control is composed of 2 input boxes. The first one, **Expression**, is used to input either a numerical value (for example **4.25**) or an expression, which can be an equation used variables. The second one, **Offset**, accepts only numerical input and is used to offset the expression by a value. Clicking the **Evaluate** button will give the current value of Expression + Offset.
All units are in microns.

In the center of the dialog, the **Major radius**, **Minor radius** and **Orientation angle** can be defined in the same way.

- **Major radius** controls the radius in the major direction of the ring
- **Minor radius** controls the radius of the minor direction of the ring
- **Orientation angle** controls the angle between the major direction and the Z axis.

The **Width** box controls the size of the ring, which is the distance between the outer edge and the inner edge of the ring. The **Depth** box controls the position of the ring in the **Y dimension**.

Finally, The **Profile** list enables you to choose between the different material profiles defined in the Profiles and Materials editor.

More detailed explanations on the **Ring waveguide** and all other objects can be found in the User’s Reference Manual.

### 3.6 Checking the properties of the input source

Now that we have verified the materials properties and the geometry of our simulation, we can check the properties of the light source.

The source is defined under the **Sources** node of the project browser. You can define as many sources as needed. They can be of 4 types:

- **Z-direction Input Plane**: The light intensity distribution is defined across an incidence plane oriented in the XY plane, light propagates in the **Z direction**
- **X-direction Input Plane (2D)**: The light intensity distribution is defined across an incidence line parallel to the Z axis, light propagates in the **X direction. This source is only valid for 2D simulations**
- **Point-source**: Light is emitted in every direction (spherical waves) from a source point. This source is defined as a radiating dipole.
- **Total-Field Scattered Field (TFSF)**: planar source used mainly for particle scattering simulations. It is only defined for 2D simulations.

For each type of planar source, the light distribution across the plane of incidence can be of 4 types:

- **Gaussian**: the light intensity follows a Gaussian distribution
- **Rectangular**: the light intensity follows a rectangular function. It is often used to approximate a plane wave
• **Modal:** The light intensity distribution is defined by an electromagnetic transverse mode in a waveguide. This mode can be calculated by OptiMode.

• **User-Defined:** You can provide your own data to define the intensity distribution.

Finally, the light source itself can be either monochromatic or polychromatic. In the monochromatic case, we use a **Continuous Wave (CW)** to describe the light source. In the polychromatic case, we use a **Gaussian Modulated Continuous Wave (GMCW)** to describe the light pulse.

### 3.6.1 Obtaining the geometrical parameters of the source

To verify the geometrical parameters of the source used, proceed to the following steps:

1. Double-click on the node named *InputPlane1* in the project browser. *The Input Field properties dialog opens.*

   ![Input Field Properties dialog](image_url)
Getting Started

In this dialog, you can define the type of light distribution across the plane (in our case, we use Modal) and the position of the plane in the Z-direction.

In our ring simulation, we use a Gaussian Modulated Continuous Wave to define a pulse which duration half-width is $1.2 \times 10^{-14}$ s and offset $4.5 \times 10^{-14}$ s, centered around 1.4 um in wavelength. These parameters give a pulse which wavelength spans between 1.3 and 1.5 um (200 to 230 THz). More details about defining sources can be found in the Technical Background manual.

3.6.2 Reviewing the temporal definition of the source

To review the temporal definition of the source, perform the following:

- Click on the tab labeled Gaussian Modulated CW
  
The Gaussian Modulated CW tab opens.
You can zoom in/out or pan in the graph windows by right clicking inside one of them and selecting the appropriate tool. If you zoom in on the time series window, you can notice that the amplitude of light is asymptotically zero at the origin. As a rule of thumb, always ensure that the time offset is properly set so that light is "turned on" slowly. Avoid transients in the light injection.

Checking the Default Time Offset and Half Width box will ensure this condition is met. It will also give you the biggest bandwidth possible given the central wavelength provided in the wavelength box on the top of the dialog.

3.6.3 Defining the light distribution properties

Finally, you can define the properties of the light intensity distribution across the plane by doing the following:

- Click on the tab labeled "2D Transverse"

  The 2D Transverse tab opens.
Getting Started

You can see that this dialog is mostly empty. It is because we haven't calculated a mode yet. To do this, perform the following actions:

2D Transverse tab

You can see that this dialog is mostly empty. It is because we haven't calculated a mode yet. To do this, perform the following actions:
1. Click the **Find Modes...** button to open the mode 2D solver

2. In the **Select waveguides for mode calculation list**, click the check-box on the left of the 1\textsuperscript{st} line. This will select the waveguide named **Linear1** at position $X = 2\ \mu m$ for mode calculation.

3. Click the **Calculate Mode** button on the right to solve the modes of the waveguide cross-section. *The Modes will be displayed*

4. Click the checkbox next to Mode No. 0 to display the mode intensity distribution. *The graph window updates to show the mode and geometry of the waveguide.*

5. Click **Apply Data** to affect the selected mode to the input source.

6. Click **Ok** to close the **Input field properties.**

*Calculated Mode displayed in the 2D Mode Solver*
Getting Started

In the Mode Solver, you can modify parameters such as polarization, number of modes to find and sampling in the Parameters tab.

Our simulation is almost ready, we only need to define detectors in order to record and be able to visualize data from the grid.

### 3.7 Checking the Detectors definition

The detectors are regrouped under the **Detectors** node of the project browser. You can use as many detectors as needed. You must keep in mind however that they will add some overhead time to your simulation. Detectors can be split into 3 categories:

- **Observation Points**: They are used to record data from a single point in space. They can give time information about the fields amplitude or, using Discrete Fourier Transform (DFT) of the time data, the spectrum at a specific point in space.

- **Observation Lines (2D)**: They are specific to 2D simulations. You can position a line following the X or Z direction and record the spectrum at each point on this line.

- **Observation Areas (3D)**: They are specific to 3D simulations. You can define a XY, XZ or YZ oriented observation area and record the spectrum at each point in this area. The result is a 2D graph of the amplitude of the fields at each point of the area. You can also record a **movie** of the fields amplitudes and follow the light propagating across your area.

In order to access the 1st Observation Point definition in our simulation, do the following:

- Double-click the top-left small green dot in the design or double-click the **ObservationPoint1** node in the project browser.

  *The Observation Properties – Point dialog opens.*
Observation Properties – Point dialog

You can see that the position of the point is defined in the same way as the waveguides. Our detector is positioned at coordinates $X = 2 \ \mu m$, $Y = 1.25 \ \mu m$ and $Z = 1.2 \ \mu m$.

In the **Data Components** tab, you can individually select which field components will be recorded during the simulation. The more components recorded, the more memory and the slower the simulation will be, especially for observation areas and movies.

We are now ready to start a 2D simulation.
3.8 Running a 2D simulation

In order to run the simulation, the program will need to write temporary and result files to disk. You need to have write access to the directory where you project file is stored. You must now save your project file to a place where you have write access:

- Go to File > Save As... in the menu bar and choose an appropriate folder (for example My Documents) and filename before clicking Save.

To access the 2D simulation parameters, do the following:

- Double-click on the 2D simulation... node in the project browser. The Simulation Parameters dialog opens.
1. Launch the simulation by clicking Run...

   The Simulator window appears and the simulation is performed

2. When prompted, answer Yes to open the Analyzer
Getting Started

3.9 Analyzing the simulated data

The OptiFDTD Analyzer window looks very similar to the Designer window.

Analyzer window

In this window, you can review the geometry of the design in the Layout or 3D editor views, or check the refractive index distribution in the Refr_idx view. You can switch between views by using the tabs on the bottom of the main view.

⚠️ If you use an anisotropic material in your simulation, you can change the component displayed in the refractive index view by choosing going in the View -> Refr. Idx. Visualizer menu and choose the appropriate refractive index component.

To access the detectors data, perform the following action:

- Go to Tools-> Observation Area Analysis
  
  The Observation Area Analysis dialog opens.
3.9.1 Observing the time series data

By default, the Observation point analysis tab is open. The graph represents the amplitude of the $E_y$ component as a function of time. You can choose which detector to display in the list beneath the graph. Here we overlaid both ObservationPoint1 and ObservationPoint2 to display the initial impulse (in black) and the harmonics at the output of the ring (in blue).

You can see that the output gets more and more damped at each new turn of the ring since some light gets out of the grid at each turn.

3.9.2 Extracting spectral information
Getting Started

Using **Discrete Fourier Transform (DFT)**, it is possible to extract the spectrum from the time series of the observation points. To do this, follow these steps:

- Click **Frequency-DFT**
- Change the values of **Min** and **Max wavelengths** to respectively 1 and 2 um.
- Click **Update graph**
  > *The graph shows the calculated DFT spectrum*

**DFT spectrum of the point detector**

You can now see the characteristic spectrum of a ring resonator, where the resonant wavelength and its harmonics are coupled into the ring and show as a drop in transmission in the waveguide.
3.9.3 Exporting the data to file
You can save the spectral data for latter use using the Export Data... button of the Observation Area Analysis dialog. To export only the DFT spectrum of the ObservationPoint2, do the following:

1. Click Export Data...
2. Click the + icon next to ObservationPoint2
3. Check the box next to DFT
4. Right-click DFT and select DFT specification...
5. In the dialog, change the values of Frequency Min. and Frequency Max. to 150 and 300 THz respectively.
6. Click Ok
7. Click Export

The exported file is available in the same folder as the project file.

3.10 Working with the 3D editor
When working on a 3D simulation, the 2D XZ view of the layout editor (which is displayed by default) can become insufficient. You can use the 3D editor to better visualize and select objects in a 3D environment.
The 3D editor

To open the 3D editor, do the following:

- Click on the 3D editor tab in the main view window
The 3D editor displays the full 3D simulation domain, including the substrate (blue) and cladding (light green) domains. On the bottom left corner, the colored trihedron gives an indication on the orientation of the view in 3D space.

### 3.10.1 Mouse Navigation

To orient the view, you can use the following mouse operations:

- **Rotate the view**
- **Zoom In / Out**
- **Pan the view**

*Mouse Operations*

When rotating the view, you can see the simulation domain and objects around every desired angle. To rotate, hold the left mouse button while moving the mouse to the desired direction. To get better details or to have a more global view, you can use the mouse wheel to zoom in or out. Scroll the wheel forward to zoom in, scroll it backward to zoom out. Finally, if you want to move laterally (pan) in the 3D view, you can hold the right mouse button while moving the mouse in the desired direction.

### 3.10.2 3D editor toolbar

On the right side of the Main view, you can find the 3D editor toolbar, you can use it to change the view displayed on the screen:
Getting Started

3D editor toolbar

You can switch between a perspective 3D view and the 3 orthographic projections using the 3D, XZ, XY and YZ buttons. Clicking the 4Q button will divide the main view into 4 views: 1 perspective 3D view and the 3 orthographic projections.

The wireframe view button will switch to a mode where all objects are displayed using a wireframe representation instead of facets. This mode can be useful if some objects are hidden behind others and viewing them becomes difficult.

3.10.3 Selecting objects in the 3D view

Finally, you can select an individual object directly in the 3D view by left-clicking on it. It will become red and a grey box will be displayed around its name in the project browser. By double-clicking an object you can pop-up its properties dialog box and modify its geometry more precisely or assign a material to it.
Selected sphere properties